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What is Adobe XD?

In case you are new to the UI/UX design world or you have spent the last year of your life on a desert island, Adobe XD (aka Experience Design) 

is a new design and prototyping tool developed by Adobe.

By using one unique powerful tool, XD allows you to easily wireframe, design and prototype web & mobile products and experiences.

Adobe XD was previously known as “Project Comet” and was launched in February 2016, as a preview version and only for Mac, with a very 

limited amount of features.

Month after month, Adobe released new updates, adding more and more features based on the feedback received by its growing user base.

At the time of writing this guide (Aug 2017), Adobe XD has grown into a solid and fast piece of software, available as a Beta version for Mac OS, 

Windows 10, iOS and Android. 

Adobe has yet to disclose when the Beta testing period will be over and the full version of XD will be released.

Download XD

Adobe XD can be download for free from here (https://www.adobe.com/products/xd.html)for both Windows and macOS.

You can also download the free XD mobile apps from the Itunes App Store or the Goole Play Store , allowing you to preview your designs and 

prototypes on mobile.

Shape the future of Adobe XD

The XD product team has done a great job so far in listening to users’ feedback. You can contribute in shaping the future of this product by 

participating in the XD Uservoice forum.

You can post feature requests, raise bugs and check the status of what’s been suggested and reported so far.

Also, make sure you follow @AdobeXD on Twitter for daily news and updates about Adobe XD and UX design in general.

About this guide

Although still in Beta, Adobe XD’s set of features keeps on growing with every monthly update, so I thought it would be useful for the whole XD 

community to have a complete and up-to-date written guide covering every single feature included in XD.

You can use it as a quick reference if you don’t know or don’t remember how to do something. Or if you are a total noob, you can read it from the 

beginning and get to learn Adobe XD step by step.

It has been structured as a big 11,000 words written tutorial, spread across 26 chapters, starting from the very basics at first, and then gradually 

moving on to more advanced topics.

It’s quite easy to navigate by using the chapters list on the left (or at the bottom on mobile) and I tried to write it as a more conversational guide, 

rather than a cold software documentation.

Ready to start?

I really hope you find it useful, 
it took me quite some time to 
create it!
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The interface

When you launch Adobe XD, a “start window” will pop up

Here you can choose the size of your artboard, which represents the screen of the app or the page of the website you are going to design. You 

can also quickly open files you worked on recently, start a tutorial or access UI kits and other resources.

Once you choose an artboard to work with, you will see the main XD workspace. It’s a pretty basic and minimalistic user interface, but very 

functional. It allows you to perform the most common actions with just a few clicks. 

These are its main areas:
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Menu bar

Top horizontal panel

On the left, we have the “Design / Prototype” switch (1).

When you are in Design mode you can make all those changes impacting the visual side of your project.

When you are in Prototype mode, you’ll be able to give life to your designs and create an interactive prototype by connecting the screens or 

pages of your project.

On the right side, we can find the zoom dropdown menu (2), which I personally never use as we already have a zoom tool on the left side of the 

screen (which works great). This element is useful to quickly check what’s the current zoom level, but I never use it to change the zoom.

The little phone icon next to it (3) enables the real time preview feature, allowing you to preview your project on your mobile device by using 

the Adobe XD app, available for both iOS and Android. This feature works extremely well and shows you exactly how your design looks on a real 

device.

Next to it, we have a little play icon (4) which allows you to preview your project directly on your computer.

And finally we have a share icon (5), allowing you to share your prototype with your clients, team members or stakeholders, in order to get 

direct feedback on it without having to go through emails or chats.

At the very top of the screen we have the classic Mac OS or Windows menu bar. Not really 

a part of the Adobe XD’s UI, as every application has it.. anyway from here you can do basic 

stuff like saving and opening files, exporting assets, and pretty much every sort of operation 

available on Adobe XD.

You can explore and use all of these options from this menu, but it would be better if you 

learned all the most common shortcuts so that you can be more productive with XD. We will 

see them in the following chapters.
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Left toolbar

Here we have all the main tools available in Adobe XD.

From the top:

• select tool (also accessible by using the V key shortcut on the keyboard)

• rectangle tool (R)

• ellipse tool (E)

• line tool (L)

• pen tool (P)

• text tool (T)

• artboard tool (A)

• zoom tool (Z)

And then at the bottom:

• Assets panel

• Layers panel

I suggest you learn by heart the shortcuts above as soon as possible. You will use most of these tools all the time, and the shortcuts will greatly 

speed up your workflow. 
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Right hand panel (property inspector)

In this panel you can find several settings allowing you to view or change the properties of your objects:

• alignment options

• repeat grid

• combining options (boolean operators) 

• objects size & positioning

• text styling

• opacity

• fills

• borders

• shadows

• blurs

In the following chapters we will see in detail all of the tools, features and options  

mentioned so far.
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Artboards

An artboard represents the app screen or the website page you are going to design. It’s the white area where the actual design objects are 

going to be drawn.

Each .xd file can contain a huge amount of artboards, as they are all positioned in a massive 50,000 x 50,000 px canvas (the grey background 

area, also called “pasteboard”).

You can choose the size of your artboard from a list of the most common mobile, tablet, desktop and wearables screen sizes, or you can define 

your own custom size.

For those designers coming from Photoshop and now getting into Adobe XD: forget about a different .psd file for each page you are designing. 

In Adobe XD, you can design all pages and/or screens of your website/app as artboards in the same .xd file.

You can create a new artboard in 2 ways:

• via the Start window, which is displayed when you launch Adobe XD. You can either select a preset or define your own artboard size.   

• using the Artboard tool, which you can activate from the left toolbar or by using the A key on the keyboard. Once you have this tool selected, 

you will see the list of available screen sizes on the right.

You just need to select one and then click on the canvas, wherever you want your artboard to be created.

Creating a new artboard
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You can rename an artboard by double clicking on its title, just above the top left border. You can also do it from the layers panel.

Renaming artboards

You can select your artboards in 4 different ways:

• by clicking on the artboard title

• by using the Select Tool and double clicking on the artboard background

• by using the Select tool and marquee-select one or more artboards (make sure to draw the selection area all over the entire artboard perim-

eter, or it won’t get selected)

• by selecting it via the layers panel

Once an artboard is selected, its properties will be displayed in the property inspector on the right.

Selecting and changing artboards properties
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• In the first section on top, you can change the artboard size and screen orientation (portrait or landscape).

• In the “Scrolling” section, you can enable or disable the vertical scrolling feature: if enabled, once you preview your design on your computer 

or on mobile via the Adobe XD app, your artboard will be scrollable vertically past the “Viewport height” pixel value.

If you are using one of the presets screen sizes, my suggestion is to always use vertical scrolling and never change the “Viewport height” value. 

Only disable the vertical scrolling if the dotted horizontal line is bothering you while designing.

• In the “Appearance” section, you can change the fill of your artboard.

• In the “Grid” section, you can enable a grid for your artboard and, if needed, change its color and spacing.

You can save the changes you made to your grid (by clicking on the “Make Default” button) so that the same grid style will be automatically 

applied to your future projects.

Using a grid is very helpful when it comes to aligning objects in your designs.

You can easily move an artboard by clicking on its title and dragging it to the new desired location on the canvas.

If your artboards are not properly lined up and you feel like you want to tidy up your canvas, just select all the artboards you want to align and 

use the align buttons at the top of the property inspector.

Moving and aligning artboards
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Panning around the canvas & zooming

As we mentioned in the previous chapter, in Adobe XD you can design entire apps and/or websites within the same .xd file, so it’s really import-

ant that you learn how to quickly navigate through all of your artboards located on your canvas.   

To do it efficiently, you need to get familiar with panning around the screen and zooming in and out.

Panning around

To pan around, you can just use the trackpad if you are on a Mac laptop, or you can hold down the spacebar on your keyboard (you will see the 

mouse cursor turn into a little hand), click on your canvas and drag. Pretty much the same concept as panning around Google Maps.

Zooming

When it comes to zooming, there are a few ways to do that.

• You can activate the zoom tool from the left toolbar or by using the Z key.

Once the zoom tool is active, you will see the mouse cursor turn into a little magnifier with a “+” in it. Now you can zoom in by clicking anywhere 

on the canvas. Or you can marquee-select an area to zoom in (really useful when you need a detailed view on any part of your design, a button 

or an icon for example.)

To zoom out, just hold down the ALT key (the magnifier will have a “-” in it) and click anywhere on the canvas.

• You can also zoom in and out without even having to activate the zoom tool: just hold the ALT key and use the scroll wheel on your mouse. 

Very practical. 

• There are also some very useful shortcuts which will quickly set your canvas to the most common zoom levels:

CMD + 0 (Mac) & CTRL + 0 (Win): Zoom to fit   

CMD + 1 (Mac) & CTRL + 1 (Win): Zoom to 100%

CMD + 2 (Mac) & CTRL + 2 (Win): Zoom to 200%

CMD + 3 (Mac) & CTRL + 3 (Win): Zoom to selection

You can check the current zoom level by looking at the Zoom dropdown in the top right. The maximum zoom level is 6400%, the minimum is 

2.5%.
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Layers

Layers are a fundamental component of Adobe XD. Every object you create with Adobe XD is a layer.

Layers are stacked on top of each other, and their visibility in your artboards is defined by their position in the layers panel on the left side of the 

screen (If this panel is not visible, you can show it by clicking on the layer panel icon in the left toolbar, or by using the shortcut: CMD + Y (Mac) & 

CTRL + Y (Win)

Let me give you a quick example of how layers work:

let’s create a new artboard and draw a simple circle by using the ellipse tool (E). We will see in detail all the shape drawing tools in the 

following chapters, for now just follow along this small tutorial.

As you can see, as soon as the circle is created, a new layer is now visible in the layers panel.
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Now let’s go back to the artboard and draw a rectangle, by using the rectangle tool (R).
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The rectangle layer is positioned on top of the ellipse layer in the layers panel, hence we can clearly see the rectangle on top of the circle in 

our artboard.

If we try to move the rectangle layer underneath the ellipse layer in the layers panel, the rectangle won’t be visible anymore in our artboard, as 

the circle is covering it.   

Now let’s move the rectangle layer back on top of the ellipse layer, and create a new text object with the text tool (T). The text layer is now on 

top of all the others in the layers panel, so it’s visible on top of everything also in our artboard.
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Now let’s create a big rectangle the size of the entire artboard. When this layer is created, it’s on top of all other layers in the layers panel. As a 

consequence, we cannot see any other objects in the artboard, as the new rectangle is covering them all.
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But if we move this layer all the way to the bottom of the layers panel, we can now see all the layers previously created, and this light blue 

rectangle now acts as the background of our simple design.

Main takeaway: the order of layers in the layers panel sets the visibility of objects in your artboards
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Hiding and locking layers

When you hover on a layer in the layer panel, two little icons will appear:

With the “lock” icon, you can lock the layer (you won’t be able to move or edit this layer unless you unlock it)

You can also lock an object by selecting it directly in your artboard, right-clicking on it and select “Lock.” Or simply use the shortcut: CMD + L 

(Mac) & CTRL + L (Win)

With the “eye” icon, you can hide the layer (it will still be present in the layers panel, but completely invisible in the artboard).

You can also hide an object by selecting it directly in your artboard, right-clicking on it and select “Hide.” Or simply use the shortcut: CMD + ; 

(Mac) & CTRL + ; (Win)

Grouping layers

You can group two or more layers by selecting them and choosing Object > Group or using the shortcut CMD + 3 (Mac) & CTRL +3 (Win). Or you 

can right-click on the selected layers and select “Group”.

Forming layer groups is a great way of organising your objects, for example when you have objects belonging to a specific design element like 

a button or an entire section of a page, like a header or a footer.

By creating a group, you can keep your layers panel nice and tidy, and you can easily select, move or transform the entire group as if it was a 

single layer.

If you want to ungroup a layer group: select the layer group and choose Object > Ungroup or use the shortcut CMD + Shift +G (Mac) & CTRL + 

Shift + G (Win).

Or you can right-click on the layer group and select “Ungroup”.

You can also nest layer groups within other layer groups.

I highly recommend you get familiar with these grouping features as it’s really important to keep a well organised layer panel at all times, 

especially if you work in a team.

Innovative layers panel layout

The Adobe XD product team came up with an interesting and innovative way of displaying layers in the layers panel. In other design tools like 

Photoshop and Sketch, all layers from all artboards included in the entire document are displayed at the same time.

In Adobe XD, only the layers belonging to the currently selected artboard are displayed in the layers panel.

This makes it way easier to navigate through only the set of layers you really need in your current context. This is especially useful when you 

are dealing with big projects with many screens. 

If no artboards are selected, the layers panel displays a list of all the artboards in your .xd document.    

Depending on which type of layer you have created, there is a corresponding icon next to it so that you can easily recognise what kind of object 

you are dealing with: (rectangle for rectangles, a circle for ellipses, a T for text layers, a little folder for a layer group, .. ).
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Selecting and moving objects

Before making any change to an object, you first need to select it.

Selecting objects is the operation that you are likely to do more often in Adobe XD. Literally all the time!

As explained in the previous chapter, you can also select objects from the layers panel, but the best way to do that is using the Select tool, 

which you can activate by clicking on the first icon on top of the left toolbar, or using the letter V on the keyboard (learn this shortcut!).

Once the Select tool is active, your mouse cursor will change to a pointing arrow and you will be able to select a single object by clicking on it.

When an object is selected, you will see a blue border and some rounded handles around it.

If no artboards are selected, the layers panel displays a list of all the artboards in your .xd document.    

Depending on which type of layer you have created, there is a corresponding icon next to it so that you can easily recognise what kind of object 

you are dealing with: (rectangle for rectangles, a circle for ellipses, a T for text layers, a little folder for a layer group, .. ).

Selecting multiple objects

If you want to select multiple objects, there are few ways you can achieve that:

• you can click and drag from an empty area of your artboard and select everything that fits in the selection rectangle (aka “marquee-select”)
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• hold the SHIFT key on your keyboard and click on only the objects you want to select

• hold the SHIFT key and select multiple consecutive objects in the layers panel

• hold the CMD (Mac) / CTRL (Win) key and select multiple objects in the layers panel by clicking on them, even if not consecutive
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Moving objects

You can move an object by selecting it and dragging it with the mouse to the new desired position. 

 

Very often in UI design, you will need to move an object while keeping the same vertical or horizontal axis. To do that hold SHIFT and drag the 

object (very important!)

You can also move an object just by using the keyboard’s arrow keys. Each tap on the arrow keys will move the object by 1px, but if you hold 

SHIFT, it will be moved by 10px.  

Selecting objects within layer groups

Things get a bit trickier when you want to select objects included in layer groups. 

 

If you click only once on a layer group, the whole group will be selected, so if you want to select a layer (or layer group) included in a parent 

group, you need to double click on it. Depending on how “deep” it is into the group, you might have to double click a bunch of times until you 

get to select it. 

 

In case you have a lot of nested layer groups and you want to select a specific layer right away (regardless of its depth in the layer groups 

structure), just hold CMD (Mac) or CTRL (Win) and click on the layer. It’s a big timesaver, it will save you a lot of double-clicking!

Aligning with Smart Guides

As you move objects around your artboards, Adobe XD will automagically show some snap guides, which are a great help when it comes to 

positioning and aligning your objects.

There are 2 types of guides:

• blue guides: showing you when an object is aligned with other objects or when it’s centered vertically and horizontally in the middle of the 

artboard or the parent object containing it.

When these guides are displayed, the object will snap automatically to them and will help you positioning them. 

• pink guides: showing you the distance in pixels between adjacent objects and artboard edges.
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You can also display these pink guides when you are not moving an object, if you just want to measure its distance from other objects.

Just select the object and press the ALT key

By default, it will show you the distance from the artboard edges.

But if you hover the mouse over another object in your artboard, XD will show you the distance between this object and the object originally 

selected.
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Drawing basic shapes

We have already drawn some basic shapes in the last few chapters, but now it’s time to dive deeper into each shape-drawing tool available in 

Adobe XD.

Rectangle tool

This is probably the one you will be using more often: in UI design, rectangles are used for a wide range of purposes.

To draw a rectangle, first select the rectangle tool from the toolbar or use the R shortcut, and then click and drag diagonally until the rectangle 

has the size you are looking for (which you can check from the property inspector on the right).

If you want to draw a square, you need to do the same while holding the SHIFT key. You will notice that width and height of the rectangle are 

constrained to be the same.

With Adobe XD, it’s incredibly easy to edit the corner radii of rectangles and squares.

If you want to change all of the corners simultaneously, you can either drag one of the rounded handles included within the rectangle, or 

change the corner radius setting in the property inspector.

If you want to change the radius of a single corner only, you can either drag one of the rounded handles within the rectangle while holding ALT, 

or you can select the multiple radius icon in the property inspector, and set manually the px value of each radius.
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Ellipse tool

To draw an ellipse, first select the ellipse tool from the toolbar or use the E shortcut, then click and drag diagonally until you have the ellipse of 

the size you want.

Truth is, you won’t be drawing many ellipses, but you will need to draw circles quite often!

So to draw a perfect circle, just hold down the SHIFT key while you click & drag.

Ellipse tool

To draw a 1px line, first select the line tool from the toolbar or use the L shortcut, then click and drag until you have the line you want.

By holding down the SHIFT key while doing that, you’ll make sure that the line drawn will be perfectly vertical, horizontal, or 45 degrees diag-

onal.
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Working with Text

To type some text in your XD artboard, select the text tool from the toolbar (or use the T shortcut), click on the location of your artboard where 

you want the text to begin and type your desired text.

When you are done and you want to commit the text and exit the “type mode”, just hit the ESC key, or click on another tool from the toolbar.

The text you just typed will be laid out on a single line and will expand until you stop writing or hit a line break.

This is perfect when you need fairly short pieces of text in your design.

Text areas

If you need to add lengthy paragraphs of text, which have to fit correctly in your layouts, it’s better to use a text area.

To do that, activate the text tool, click on the location of your artboard where you want the text to begin and drag to define the size of your text 

area.

Then click inside the text area and type your text. You will notice that when the text reaches the right boundary of the text area, a line break 

will occur automatically, so that the text can fit perfectly within the area you defined.

You can easily resize the text area by using the handles located along its border.

As you probably have noticed, when the text tool is selected or when you select a text object, you can see a “Text” section in your property 

inspector on the right.

In this section, you will be able to change:

The font you are currently using

The text size

The font weight

The text alignment (left, center, right)

The character spacing (distance between each character of a string of text)

The line spacing (vertical distance between each line of a given text block)

Text areas

If you need to add lengthy paragraphs of text, which have to fit correctly in your layouts, it’s better to use a text area.

To do that, activate the text tool, click on the location of your artboard where you want the text to begin and drag to define the size of your text 

area.

Then click inside the text area and type your text. You will notice that when the text reaches the right boundary of the text area, a line break 

will occur automatically, so that the text can fit perfectly within the area you defined.

You can easily resize the text area by using the handles located along its border.

As you probably have noticed, when the text tool is selected or when you select a text object, you can see a “Text” section in your property 

inspector on the right.

In this section, you will be able to change:

The font you are currently using

The text size

The font weight

The text alignment (left, center, right)

The character spacing (distance between each character of a string of text)

The line spacing (vertical distance between each line of a given text block)
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Keep the same style when writing new text

When you type a new text string, Adobe XD uses a default font, size and color (Helvetica font, 20px, grey).

This is not always ideal, especially if you are working on a project using a completely different style of typography.

There’s a way around it: before creating a new text string, select a text layer having the style you would like to replicate. Then select the text 

tool again and write your text: its style will match the previously selected text layer.

You can also quickly adjust the size of a text object directly from the little handle visible at the bottom of each text object. You just need to 

click and drag it.
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Styling Objects: fills, borders, shadows, blurs

When an object is selected, you will be able to change all its styling options from the property inspector, under the “appearance” section:

Opacity slider

It controls the transparency of a selected object.

100% is the default value, which means fully visible.

At 0%, the object is completely invisible.

Fill

It controls the color of a selected object.

By clicking on the little color rectangle, the color picker will popup (more on this in the next chapter).

Next to it, there’s an eyedropper icon. When clicked on, you will be able to pick a color from the entire Adobe XD’s canvas and interface. This 

color will become the new fill color of your selected object.

Border

It controls the border properties of a selected object.

You can change the border color and its thickness. You can also pick an existing color with the eyedropper icon.

Shadow 

It controls the shadow properties of a selected object.
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• By setting the x and y values, you will define where the shadow will be cast (left, right, top or bottom).

• The B value controls the blur of the shadow.

• You can also change the shadow’s color and opacity by using the color picker.

Blurs

With this option you can add a cool blur effect to a selected object, which is a technique often used in UI design, mostly applied to background 

images or as an overlay to entire sections of an app.

When you blur objects in Adobe XD, the changes you apply are non-destructive, meaning that you can always recover the original version of 

your object just by disabling the blur effect (this is not the case in other tools like Photoshop). 

There are 2 ways you can use this feature. You can select which one from the little dropdown menu next to the blur checkbox:

Background blur:

This method is suitable if you want to blur a specific portion of an image or artboard.

Here’s how to achieve this:

• draw a shape on top of the image or the area of your artboard you would like to blur

• select the shape and choose “background blur” from the dropdown menu

• adjust the 3 sliders below in order to obtain the desired blur effect:

Blur amount: sets the power of the blur

Brightness: sets the brightness of the blur

Opacity: sets the opacity of the blur

Object blur:

Use this method if you want to blur an entire object.



Adobe XD CC Classroom28



Adobe XD CC Classroom29

Here are the few areas of the color picker we need to pay attention to:

(1) Switch between Solid Color and Gradient. We’ll see gradients in te next chapter, in this chapter we’ll deal with Solid Colors

(2) The larger square is where you actually select the color you want

(3) The first colorfoul vertical stripe allows you to quickly navigate through different colors

(4) The second vertical stripe controls the color opacity. Drag the handle to the bottom to lower the opacity. The change will also be reflected 

in the “A” (alpha) value just below it. 

(5 & 6) For each color you select, Adobe XD will display its HSBA value (Hue, Saturation, Brightness, Alpha – or opacity) and a Hex value. You will 

pass these values to your front-end developers, or use it directly if you are the one coding your own designs.  

(7) When you click on the “+” icon, the color currently selected will be added as a favourite color (swatch) at the bottom of the popup. All your 

swatches will be lined up here and will be available every time you open the color picker, for any artboard within the same .xd document. It’s 

a super useful way of having all the colors you need in one place. You can remove a swatch by clicking on it and dragging it out of the color 

picker popup.

The Color Picker

As we have seen in the paragraphs above, the color picker is accessible when you have an object selected, by clicking on the little color rect-

angle next to any fill, border or shadow.



Adobe XD CC Classroom30

Gradients

A gradient is a combination of 2 or more colors blending into each other, a color technique used quite often in UI design recently.

When you select “Gradient” from the dropdown at the top of the color picker, a horizontal stripe will be displayed just below it, where you will 

be able to preview and edit your gradient.

The two small circles that you see at each opposite side of the gradient stripe (1 & 2), are the two colors currently used in the gradient.

If you want to change those colors, you have to click on one of the color stops and select a different color from the color picker.  

Some color stops (3 & 4) are also displayed in the gradient editor that appears on the object your gradient is applied to.

You can change the color of your gradients from there too, and you can also change the gradient direction, by moving the color stops in differ-

ent directions until you reach the desired result.

Adding colors to a gradient

By default, a gradient has 2 color stops, but you can add more colors if you want: just click on the gradient stripe in the color picker. Each time 

you click, a new color stop will be created. The new stop will immediately be created also in the gradient editor on top of your object.



Adobe XD CC Classroom31

Adding colors to a gradient

By default, a gradient has 2 color stops, but you can add more colors if you want: just click on the gradient stripe in the color picker. Each time 

you click, a new color stop will be created. The new stop will immediately be created also in the gradient editor on top of your object.
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Removing colors from a gradient

If you want to remove a color stop from your gradient, you can do that in 2 ways:

• in the gradient stripe on top of the color picker, click on the color stop you want to remove and drag it outside of the color picker area

• in the gradient editor on top of your object, click on the color stop you want to remove and hit the Delete key on your keyboard

At the moment only linear gradients are available in Adobe XD, but this is more than enough to come up with some very cool gradient effects!
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Duplicating Objects

When designing with Adobe XD, you will very often need to duplicate a specific object and make changes to it, rather than creating a new one 

all the time. This allows you to keep the copied object’s style and properties.

There are a few ways you can duplicate a selected object:

• Choose Edit > Duplicate, or use the shortcut CMD + D (Mac) & CTRL + D (Win). The new object will be positioned right on top of the original 

object in the layers panel.

• hold the ALT key and click&drag the selected object to duplicate it. Also in this case, the new object will be positioned right on top of the 

original object in the layers panel.

• Simply copy and paste the selected object like you would do with Word or Excel: CMD + C (Mac) & CTRL + C (Win) to copy, CMD + V (Mac) & CTRL 

+ V (Win) to paste.

You should use this method if you want to have control on where the new object will be positioned in the layers panel.

If for example you want to duplicate an object included in one layer group, and you want it to belong to another group, just copy it first, select 

the desired layer group destination from the layers panel, and then paste it.

Doing this will save you a lot of moving layers around the panel.

This is also the right method to use if you want to copy an object to a different artboard.

If you just copy and paste object without choosing its new position in the layers panel, the copied object will be positioned right on top of the 

layers panel, above all other layers.

Duplicating Styles

Since the August 2017 update, you can copy the style of an object and easily apply it to another object.

It’s a great timesaver: all you have to do is copy the object with the style you want to duplicate, then right click on another object and select 

“Paste appearance“.

The first object’s style will be instantly applied to the second object.
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Resizing

Another action you will do very often in Adobe XD is resizing objects, especially shapes and images. 

You can resize an object by using one of the rounded handles you can see all around the object when you select it. 

• If you want to resize just one size of the object (of a rectangle for example), use one of the 4 handles located at each side of the rectangle, 

depending on which side you want to increase or decrease.

• If you want to resize the whole object while keeping its proportions (the ratio between width and height of a rectangle or an image, or if you 

want to resize a perfect circle) just hold down the SHIFT key and use one of the handles located at each corner of your object.

This is an action you’ll perform fairly frequently, so I suggest you get comfortable with it.
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• If you hold down the ALT key, the object will be resized from its center instead of from the sides.

• In some cases, it can be easier to resize objects directly from the property inspector on the right, by simply changing the W (width) and H 

(height) values of your object.

Rotating

To rotate an object, first select it, then move the mouse cursor very close to one of the rounded handles around the object, until it turns into a 

rotation cursor
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At this point, just drag the handle in the direction you want the object to rotate to.

By holding down the SHIFT key, your object will rotate by 15 degrees increments. This is very useful if you want to precisely change the orien-

tation of your object.

You can also change an object orientation via the property inspector on the right, by editing the orientation value
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You can also align objects relative to their position on the artboard. Just select an object and use one of the alignment options described 

above.

Align and Distribute objects

The options included at the very top of the property inspector are really useful when it comes to aligning and distributing objects in your XD 

document.

To align or distribute object, first select two or more objects and then click on one of the options available. Here is a quick explanation for each 

of them:
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Combining shapes: Boolean Operations

In Adobe XD it’s very easy to combine basic shapes in order to create more complex ones, by using the combining options located in the 

property inspector, also called “Boolean Operators”.

There are 4 different boolean operators available

• Add: The resulting object is the sum of the original 2 shapes combined

• Subtract: The resulting object is a shape where the area of the shape on top has been cut out from the shape at the bottom

• Intersect: The resulting object is the overlapping area between the 2 shapes

• Exclude overlap: The resulting object is basically the opposite result of the “Intersect” operation, where the new shape is made of the areas of 

the 2 shapes that do not overlap.

When you combine some shapes, the result will be also reflected in the layers panel: every shape combination will represent a specific type of 

layer, which can be easily modfied.

Boolean operations are non destructive, meaning that you can always go back and change the way you combined the shapes, or even cancel 

the shape combination by selecting the combined layer and ungrouping it: CMD + Shift +G (Mac) & CTRL + Shift + G (Win) 
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Repeat Grid

This is one of the most amazing and innovative features in Adobe XD.

With the Repeat Grid, you can easily create a list of repeatable elements and manage its style and content in a blink of an eye.

This feature is a huge time saver when you have to design pages or screens with lists of repeating elements and you need to choose which 

layout and style works best.

It will save you a lot of repositioning and restyling: all you have to do is make changes to one of the elements included in the repeat grid, and 

that change will be automatically applied to every other object!

Here’s how it works:

1. Design the first element which you want to repeat. In our example we’ll design a list of apartments, so let’s design one “apartment box”.  

You should group all the objects included in this element so that it’s easier to manage and move.

2. Select the entire layer group and click on the “Repeat Grid” button in the property inspector on the right. You will notice that a green dotted 

line and two large handles will appear around the element. 

3. Drag one of the two green handles to repeat the element horizontally or vertically. Notice how easy and fast it is to create a list from the 

element you originally designed.
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4. With the repeat grid selected, if you want to change the distance between the elements in the grid, just hover with the mouse over the space 

between them. You will see the mouse cursor change into 2 arrows and the space between the elements will be highlighted in pink. You can 

just click and drag until you reach the desired spacing between elements. You can do this for horizontal and vertical spacing.
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5. If there are images in your list, like in our example, you can easily replace all the images in one shot. Just save locally all the images you want 

to add (be mindful of image size and weight), then select them all and drag them into your repeat grid, aiming at the shape which will include 

the image.

Magically, all the images in the list will be replaced with the ones you just dragged in.

6. Now that we have our nice list, try to make any change to any of the elements in the list. Move a piece of text, or change its color or its size, or 

increase the width of the box.

You will notice that the changes you make are immediately replicated to all the other elements in the list.
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All you need to do is drag this file from your local folder into XD, exactly on top of the text object you want to replace. All the instances of this 

object included in the list will be replaced with the text strings you wrote in your .txt file. So fast!

Can you see why this feature will give you a huge productivity boost? Truly amazing stuff.

If you want to ungroup all the grid elements in order to work on each of them separately, select the repeat grid and click on the “Ungroup grid” 

button in the property inspector.

Quickly import content from a text file

Talking about editing text within a repeat grid, there is a very smart and easy way you can do that, faster than editing each piece of text individ-

ually.

You can write all the text you want to be included in the text elements of your list in a text file.

Let’s say you want to change the 8 titles of our example. You can write these 8 titles, separated by a line break, in a .txt file and save it on your 

machine.
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Editing shapes

Every shape in Adobe XD is a vector path defined by a start and an end point, and can be easily edited at any time.

When you double click on a shape, you will enter the “path edit mode” and all the shape’s anchor points will become visible.

While in “path edit mode”, you can manipulate your shape by editing and removing existing anchor points, or by adding new ones to the exist-

ing path.

You can select an anchor point just by clicking on it (the selected anchor point will change its color from white to blue).

You can select multiple anchor points by holding SHIFT and clicking on all the anchor points you want to select simultaneously, or by mar-

quee-selecting them.  

Once an anchor point is selected you can:

• Double click on it to convert it from straight to curved, or vice-versa

• Hit the DELETE key to remove it
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• Click & drag it until you obtain the desired effect on your modified shape

You can also add a new anchor point to your shape by hovering with the mouse on the path border, and when the cursor icon turns into a pen 

(Pen tool is active), click on the exact location of the path where you want the anchor point to be added.

The pen tool

As we have seen above, the Pen tool is key when it comes to editing shapes, creating custom ones or paths in general.

You can activate this tool by selecting it from the left toolbar, or by hitting the P key.

Once activated, you can start drawing your shape or path by clicking anywhere on your artboard to create the first anchor point.

As you create more anchor points, you will notice that they are being connected by a straight line, which is forming your vector path.

By holding down the SHIFT key, you’ll make sure that the path segments drawn will be perfectly vertical, horizontal, or 45 degrees diagonal.

You can close the path and form a custom shape by clicking on the first anchor point you created. You will be able to change all the properties 

of this new shape as you would do for any other basic shape (color, border, shadow, ..)  

You can also leave the path open by hitting the ESC key, in case you just need to create a specific stroke or a curve for example.
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Draw curves

To draw a curve, select the Pen tool and position the cursor where you want the curve to begin and hold down the mouse button.

Drag out the cursor to set the slope of the curve and then release the mouse button.  

You will notice that a curved line is now visible, and if you click again, it will get drawn on the artboard.

You can edit the slope of the curve by using one of the handles connected to each anchor point of your curved path.
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Masking

In UI design, masks are used to show a specific part of a layer, in order to draw attention to it. One of the most popular example of masking can 

be a simple profile photo, which on many mobile apps is contained within a circle. You can achieve this via masking:

• Choose the image you want to mask. In this case if a photo of a guy.

• Draw a perfect circle and position it on top of it, exactly on the area of the photo you want to highlight.

• Now select both the circle and the image layers and select Object > Mask with Shape or use the shortcut CMD + Shift +M (Mac) & CTRL + Shift + 

M (Win).

In the layers panel, a new masked object will be created and it will have a specific mask icon.

Masking is a non-destructive operation, as the masked area of your layer does not get deleted, it can be edited at any time.

If you double click on the masked object, you will be able to move either the masking shape or the masked layer and obtain the result you are 

after.

To disable masking from a masked object, select the objecta and select Object > Ungroup Mask.
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The Assets panel

The Assets panel has been introduced by Adobe in the August 2017 update.

This section is located on the left side of the screen, and, if not visible by default, it can be displayed by clicking on the Assets panel icon at the 

bottom of the left toolbar.

In this section you can see, edit and re-use the Colors, Character Styles and Symbols present in your XD project.
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Colors

Add Colors to the Assets panel

The colors used in your project are not included by default in the Assets panel. If you want them there, you need to add them first.

• You can easily add every single color used in your project by first selecting all the artboards in your document and then clicking on the “+” icon 

next to the Colors label in the Assets panel. The Colors section will now expand and show a list of every single color and gradient used in your 

project.

• If you don’t want to all the colors of your project, but just a few ones, then only select the objects you want their color to be included in the 

Assets panel and then click on the “+” icon.

Apply and manage Colors from the Assets panel

You can easily apply the colors included in your Assets panel to new or existing objects included in your XD document.

• To apply a fill color, just select an object and then click on the color you want to apply in the Assets panel. The fill of the object will be instantly 

changed to the new color. You can do the same thing by right clicking on the color thumbnail in the Assets panel and selecting “Apply as fill“.

• To apply a border color to an object, select it, right click on the color thumbnail in the Assets panel and select “Apply as border“.

• By right clicking on a color thumbnail in the Assets panel you can also Edit the color, copy its Hex values, or delete it from the Assets panel.

Character Styles

Add Character Styles to the Assets panel

As for the colors, also the character styles used in your project are not included by default in the Assets panel. If you want them there, you need 

to add them first.

• You can easily add every single character style used in your project by first selecting all the artboards in your document and then clicking on 

the “+” icon next to the Character Styles label in the Assets panel. The Character Styles section will now expand and show a list of every single 

font style (name, weight, size and color) used in your project.

• If you don’t want to add every character style included in your project, but just a few ones, then only select the text objects you want their 

style to be included in the Assets panel and then click on the “+” icon.

Apply and manage Character Styles from the Assets panel

You can easily apply the character styles included in your Assets panel to new or existing text objects included in your XD document.

• To apply a character style, just select a text object in your document and then click on the character styles you want to apply in the Assets 

panel. The font style of the selected object will be instantly changed.

• By right clicking on a character style in the Assets panel, you can also Edit the style or delete it from the Assets panel.

Symbols

Symbols are a very specific type of objects and they deserve a chapter on their own. See the next chapter.

I suggest you get confident with the Assets panel. When used correctly, it can bring a huge productivity boost to your Adobe XD workflow.



Adobe XD CC Classroom50

Symbols

Symbols are objects that you can reuse across your artboards in a .xd document, and you can change them all simultaneously by only modify-

ing one instance of them.

Let’s say you have designed a green icon which you placed in 10 different screens of a mobile app.

If you want to make this icon blue, you can do it by only changing the color of one icon (as long as it’s saved as a symbol), instead of changing it 

10 different times. As all instances of a symbol are linked together, the change you make will be replicated across all of them instantly.

You can create a symbol by first selecting one or more objects and then using one of the following methods:

Select: Object > Make symbol

Right click on the object and select “Make Symbol”

Use the shortcut CMD + K (Mac) & CTRL + K (Win)

Click on the “+” icon next to the “Symbols” section in the Assets panel on the left

All the symbols in your document will be visible in the Symbols section of the Assets panel, on the left side of the screen.

If this panel is not visible, you can display it by clicking on the Assets panel icon at the bottom of the left toolbar.

To use a symbol, all you have to do is drag it from the Assets panel onto your artboard. Or you can copy an existing symbol and paste it into 

another artboard.

All the styling changes (position, color, size, shadow, ..) you will make to one instance of a symbol will be automatically replicated to all other 

instances.

Text and bitmap changes won’t be replicated, you can have unique text or images for each instance of a symbol. This is very useful if for 

example you are dealing with buttons having the same visual style but different text.
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Ungrouping symbols

If you want to make a change to the style of only one instance of a symbol, without having it replicated to all the existing instances, you need to 

ungroup that symbol instance.

To do that, select the instance you want to ungroup and use one of the following methods:

Select: Object > Ungroup symbol

Right click on the symbol instance and select “Ungroup Symbol”

Use the shortcut CMD + Shift +G (Mac) & CTRL + Shift +G (Win)

 

Making text and image changes to all symbols

As we mentioned above, if you want to make a text or image change to only one instance of a symbol, you don’t have to ungroup it from all 

other symbols: text and bitmap changes are not propagated across all symbol instances.

If you want a text or bitmap change to be propagated across all instances of a symbol, right click on the version of the symbol you want to 

propagate and select “Update all symbols”.

Removing symbols

If you want to remove a symbol from the Symbols section in Assets panel, right click on it and select “Remove Symbol”.
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Creative Cloud Libraries Integration

Since the August 2017 update, you can re-use colors and character styles that you created with other Adobe tools like Photoshop or Illustrator 

and saved in your Creative Cloude Libraries.

To open the Creative Cloud libraries panel in Adobe XD, select File > Open CC Libraries on Mac, or Menu icon > Open CC Libraries on Windows.

This is how the panel looks like:

Apply colors and characters styles

You can easily apply the colors and characters saved in your CC Library to new or existing objects included in your XD document.

• To apply a fill color, just select an object and then click on the color you want to apply in the CC Library panel. The fill of the object will be 

instantly changed to the new color. You can do the same thing by right clicking on the color thumbnail in the CC Library panel and selecting 

“Apply as fill“.

• To apply a border color to an object, select it, right click on the color thumbnail in the CC Library panel and select “Apply as border“.

• To apply a character style, just select a text object in your document and then click on the character styles you want to apply in the CC Library 

panel. The font style of the selected object will be instantly changed.

From the dropdown menu on top you can select which CC 

Library you want to pull colors and character styles from. 

All the saved assets will be displayed right away.
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Importing assets into Adobe XD

Quite often you will need to import bitmap images (jpg, png, gif, tiff, svg) or vector assets into your XD documents.

To import an image from your computer filesystem (Finder or Windows Explorer):

Drag and drop the file into XD

Or copy the file and paste it into XD

To import an image from your browser:

Drag and drop the image into XD

Or right click on the image, select “Copy image” and then paste it into XD

To import an image from Photoshop:

With the marquee tool, select the image you want to import, Copy it or “Copy merged” it (Edit > Copy merged) and then paste it back into XD

To import a vector from Photoshop:

right-click on a shape/vector layer, click on “Copy SVG” and then copy it back into XD.

To import a vector from Illustrator:

Select the vector shape in Illustrator, copy it and paste it back into XD.

To import an asset from Sketch:

Select the layer in Sketch, copy it and paste it back into XD.

 You will be able to edit all the imported vector assets in Adobe XD as if they were created within XD itself.
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Exporting assets

Unless the front-end developers who are going to code your designs are independent enough to retrieve the design assets directly from your 

XD file, chances are you will be the one having to export all the assets for them

By assets, I mean those design files that will be needed by the developers to re-create what you designed, using HTML/CSS/JS in case of a 

website, or native languages like Swift or Java in case of iOS and Android apps.

In general, the most common assets are bitmap images, icons and background patterns.    

You might also need to simply export some of your artboards in order to present your work to your clients or coworkers.

At the moment, in Adobe XD you can export design assets as PNG, SVG and PDF formats.

To export one or more assets:

1. Select one or multiple objects directly from your artboards or from the layers panel.

2. Select File > Export, or use the shortcut CMD + E (Mac) & CTRL + E (Win)

3. Select the format you need (PNG, SVG or PDF). There are different export options for each of these formats.



Adobe XD CC Classroom55

Export as PNG

When exporting assets as PNG, first of all you have to choose which platform you want them to be exported for:

• Design: The default option where your asset is exported at 1x resolution. Choose this if for example you just want to export one of your art-

boards.

• Web: Assets are exported at 1x and 2x resolutions.

• iOS: Assets are exported at 1x, 2x, and 3x resolutions.

• Android: Assets are optimised and exported for all the currently available Android screen densities: ldpi, mdpi, hdpi, xhdpi, xxhdpi, xxxhdpi

After choosing the target platform, you need to select the resolution at which you created your designs, from the “Designed at” dropdown 

menu.

Chances are you designed at 1x (if you used the default artboard sizes provided by XD). Some designers prefer to design at higher resolutions, 

like 2x or even 3x.

Example: if I design an iPhone7 screen at 2x, my artboard size will be 750×1334 px, which is twice the size of the standard 1x artboard 375×667.

In this case, when I export assets, I will have to select “2x” from the “Designed at” dropdown menu.

As a last step, select the destination folder and click on the Export button.

Export as SVG

This format is widely used for icons or other vector assets which need to scale on different screen sizes without losing quality, for example in 

responsive websites.

When exporting as SVG, you have two options to choose from:

Embed: the bitmap image you are saving is placed into the SVG file itself.

Link: the bitmap image you are saving is stored separately, and a reference to it is added in the SVG file.

In doubt, just choose the Embed option.

You can also tick the “Optimize asset” checkbox if you want lighter assets in terms of file sizes (the code within the SVG file will be minified, 

resulting in smaller file).

Export as PDF

PDF is not a format used when coding web or mobile apps or websites, but it might come in handy if you need to share your designs with 

clients, stakeholders or coworkers.

Select the artboards or objects you want to export and choose if you want to export them as a Single PDF file (all artboards will be included in 

the same PDF file) or as Multiple PDF files (each artboard will be saved as an individual PDF file).

Quick export (copy and paste)

If you need to quickly show your work without having to save a file on your machine, you can quickly do that by selecting your artboard or 

object, copying it and then pasting it into a chat window (Slack, Skype, Whatsapp Desktop ..) or an email.

This is really useful when you need a quick feedback from clients or coworkers.
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Importing assets into Adobe XD

Quite often you will need to import bitmap images (jpg, png, gif, tiff, svg) or vector assets into your XD documents.

To import an image from your computer filesystem (Finder or Windows Explorer):

Drag and drop the file into XD

Or copy the file and paste it into XD

To import an image from your browser:

Drag and drop the image into XD

Or right click on the image, select “Copy image” and then paste it into XD

To import an image from Photoshop:

With the marquee tool, select the image you want to import, Copy it or “Copy merged” it (Edit > Copy merged) and then paste it back into XD

To import a vector from Photoshop:

right-click on a shape/vector layer, click on “Copy SVG” and then copy it back into XD.

To import a vector from Illustrator:

Select the vector shape in Illustrator, copy it and paste it back into XD.

You will be able to edit all the imported vector assets in Adobe XD as if they were created within XD itself.

To import an asset from Sketch:

Select the layer in Sketch, copy it and paste it back into XD.

You will be able to edit all the imported vector assets in Adobe XD as if they were created within XD itself.
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Prototyping

The Prototype mode is an amazing feature which sets Adobe XD apart from other design tools.

In this mode, you can easily create an interactive prototype of what you are designing by simply connecting the artboards included in your web 

or mobile project, choosing a type of transition and previewing the final result on your computer or on a mobile device.

This allows you to test and validate the navigation, usability and overall user experience of your mobile app or website before you start with 

development, avoiding fundamental UX design flaws down the line which might cost you more time and money to fix.

1. To create a prototype, you first need to switch to Prototype Mode by using the little toggle on the top left of the page. You will notice that all 

the design related toolbars and features are not accessible anymore.

2. Now click on an artboard you want to be part of your prototype. You will notice that a little home icon appears at the top left of your artboard.

If you want this screen to be the first screen of your prototype, click on the home icon. It will turn blue, meaning that this will be your home 

screen, the first one appearing when the prototype is launched or shared.
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3. Now let’s say you want to connect the button on the first screen to the screen next to it , and create an interaction between the two. 

Select the button by clicking on it directly on your artboard or from the layers panel on the left. (note: if your object is a layer group, make sure 

you select the entire group and not just one of its individual layers).

The object will be highlighted in blue, and a little arrow handle will be displayed on the right side of it.

Click on this handle, drag the connecting line which will be displayed and release the mouse on the screen you want to connect to the button.

4. At this point, a little window will popup with some settings you may choose to edit:

Target: this is the screen we are connecting our object to. You generally do not need to change this as it picks up automatically the target 

screen when you connect the two screens together.   

Transition: you can choose from a bunch of different transition effects which you should change depending on the actual flow of your proto-

type. If for example you are prototyping the opening of a sidebar menu on a mobile app, triggered by the tap on a hamburger menu icon on the 

top left of the screen, you should use a “Slide right” transition.     

Easing: I personally don’t bother touching this setting as I don’t see much of a difference. Feel free to play with it though.  

Duration: This setting defines how long the chosen transition between the connected screens will last. I am a fan of fast transitions so I gener-

ally use 0.2s or 0.4s.
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After you are done changing these settings, or if you don’t want to change them at all, just press ESC or click somewhere on the grey canvas 

and your connection will be completed.

Repeat this process for each screen of your app or website you want to connect.

A couple more tips:

• If you want to review all the connections a specific artboard has, just click on its title: all connections to other screens will be displayed.

• If you made a mistake and want to delete a connection between two screens, just drag one of the two connecting handles on the grey canvas, 

or click on it and then press DELETE on the keyboard.

• If you want to change the target screen of a connection, you can do it through the “Target” dropdown menu, or you can just drag the destina-

tion handle to a different screen.

• You can copy and paste interactions from one object to another. If for example you have a button linking to a specific screen, with a specific 

transition and duration, you can copy this exact interaction and apply it to another button. To do that, copy the first button, then select the 

second button, right-click on it and select “Paste Interaction”
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Preview your prototype                   

You can preview the XD prototype you just created by clicking on the “Play” icon at the top right of the screen.

A preview window will popup and the currently selected artboard will be displayed. You can now click on the objects you connected and 

navigate through your prototype. 

In the same window you can also record a video of your prototype, which you can then share with your clients, coworkers or stakeholders.

To do that, just click on the little record icon at the top right side of the preview window (a timer with the video duration will start). Do all the 

actions you want to record in the video and then click on the same icon to stop recording and save it (in .mp4 format).
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Real time mobile preview

With Adobe XD, you can also preview your designs and prototypes on a mobile device via the Adobe XD iOS and Android app.

This feature is extremely important when you design mobile interfaces, as it allows you to check exactly how your designs will look on a real 

mobile device. All the changes you make on your artboards are instantly reflected on the mobile app, so you can basically create your designs 

by looking directly at your phone.

The real-time performance are amazing, everything feels super smooth and as real-time as it can get.

1. To preview your designs or prototypes on your mobile device, first download the free Adobe XD mobile app from the Itunes App Store or the 

Goole Play Store

2. Connect your phone to your computer via USB and in Adobe XD click on the mobile preview icon at the top right of the screen.

3. Your designs should now be visible also on your mobile device, mirroring the artboard you have selected on your desktop.

Not only you can preview your artboards in design mode, but also in prototype mode, where you will be able to interact with your prototype as 

you would do with a real mobile app.

As you can already do on the desktop preview, if you tap anywhere on the artboard you are previewing on your phone, all the hotspots included 

in your prototype will be highlighted in blue.

More app options

If you long press on the current artboard, the main app navigation menu will be displayed. From here, you can access a few more options:

• Browse artboards: if you are previewing a big project with dozens of screens, it can be tricky to find the one you want to preview. This feature 

helps you do just that, by showing you all the screens as thumbnails, so that you can easily tap on the one you want.

• Share screen as image: in case you want to share the artboard currently displayed via messaging apps like Whatsapp, FB Messenger, on social 

networks or via email.

• Enable/Disable hotspot hints: if you disable this, the hotspots included in your project won’t be displayed when you tap on the screen.

• View settings: just a few settings and links

• Open XD Document: from here you will be able to preview your work by loading directly your files from your Creative Cloud account.

If you are not previewing any artboards, you can do that by tapping on the folder icon on top and choose “XD Document from Creative Cloud”
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Share your designs and prototypes                   

At any point during your design or prototype workflow, you can share your work online with clients, coworkers or stakeholders, and even get 

feedback from them directly within Adobe XD.

To share your designs and prototypes, click on the share icon located at the top right of the screen.

A little “Share online” popup will be displayed. 

Now choose a name and an image for your project (if you want) and then click on the “Create link” button.

A special link will be created for you in a few seconds, which you can copy and send to whoever you want to review your work (there is also an 

option to embed your prototype in your own website). 

Once the reviewers click on the link, they will be able to see your project in their browser.

• If you shared a simple design, they will be able to browse through all the artboards included in the project by using the little navigation 

buttons at the bottom of the screen

• If shared a prototype, the reviewers will be able to interact with it. Active hotspots will be displayed when they tap anywhere on the artboard. 
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Receive Feedback

The reviewers can also provide feedback by writing their own comments, using the dedicated section on the right side of the screen.
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When reviewers write a comment using the textbox at the bottom right of the screen, they can also pin that comment to a specific area of the 

design.

They just need to click on the “Pin to artboard” link and click on the area of the artboard they want to pin their comment to. By using pins it will 

be very clear to understand which areas of the design they are referring to. 

Reviewers can write a comment by either logging in with their Adobe account or writing it as a guest (in this case they won’t be able to edit or 

remove their comments once the current session expires).  

Whenever a comment is made, you will receive a notification in the Creative Cloud taskbar, and you will be able to read it by clicking through to 

your prototype page.

There you will be able to reply to the comment, mark it as resolved or delete it.  

Manage your shared links

You can manage all the designs and prototypes links you have shared by clicking on “Manage links” in the “Share online” popup.
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